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Disclaimer 

While to the best of our knowledge, the South Australian King George Whiting 

Management Model operates as specified, no warranty, either expressed or implied, is 

made with respect to the performance or fitness for any particular purpose of the 

computer programs and written material. 

Project Sponsorship 

This model was developed under the sponsorship and support of the Australian Fisheries 

Research and Development Corporation (FRDC) Project No. 95/008, "Development of an 

Integrated Fisheries Management Model for King George Whiting (Sillaginodes Punctata) in 

South Australia", Dr. Anthony J. Fowler, Principal Investigator. Additional data and 

research support were provided by the South Australian Marine Scalefish Fishery 

Management Committee, and the marine scale fishers of South Australia. This research was 

undertaken by the South Australian Research and Development Corporation (SARDI), a 

division of the Department of Primary Industries and Resources of the state government of 

South Australia. 

Further Documentation 

For further details of the field and laboratory data collection and analysis, model structure and 

parameter estimation, and further technical information about this user interface and simulation 

software described herein, please refer to the Final Report of the FRDC project numbered and 

titled above. This Final Report can be obtained from FRDC (tel: (02) 6285 0400; or email: 

frdc@frdc.com.au). 
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SA King George Whiting Management Model 

1. Introduction

1.1. Installation 

1.1.1. Computer requirements 

To load and run the model you will need: 

1. An IBM compatible computer with a Pentium (or equivalent) chip or higher and
mathematics co-processor.

2. At least 100 megabytes of disk space and 32 megabytes of RAM.
3. Window 95/98, NT.

4. Screen display set to 1024x768 and with small fonts selected.

1.1.2. Installation 

The SA King George Management Simulator (WhitSim) is contained on a single CDROM. 

To install the WhitSim: 

1. Execute Windows

2. Insert the Installation CDROM in the CD Drive
3. Select Run ... from the Start Menu.

4. In the command line type the drive that contains the installation disk followed by

setup.exe. For example: d:\setup.exe
5. Choose OK.

6. Follow the on screen prompts.

WhitSim will then install from the CD into the directory C:\Program Files\SARDI\ WhitSim. If 

this directory does not already exist it will be created. A dialog box will appear asking if you 
want to create a Windows program group. Click on the Yes button. 

The program group will be automatically created which will contain the WhitSim icon. The 
icon will also be added to the Programs menu. 

1 
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1.2. Model Overview 

1.2.1. The Delphi Graphical User Interface 

B 
Qpen 

(f) 

(g) 

(a) Title bar - includes the name of the current project.

(c) (d) (e)

(b) Menu bar - contains the menus from which you choose commands (sometimes referred to
as menu options).

(c) Minimise button - reduces the window to a button on the taskbar.
( d) Maximise button - click on this button to enlarge a window to fill the screen. This button

will then be replaced by the restore button.

(e) Close button - closes the window.
(f) Speed buttons - shortcuts for commonly used menu commands.
(g) Model display area - space below the speed buttons where parameter and results screens

are displayed.

The graphical user interface was developed using the Delphi programming language. It allows 
easy control of the model and the display of model results. Dialog boxes will appear when you 
choose menu items. These allow you to enter selections and values. Screens containing model 
output will appear in the Model display area. 

2 
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Throughout this User Guide various aspects of the model interface will be referred to. The 

features summarised above define various aspects of the WhitSim interface and some users 

may need to refer back to this section for clarification of these terms. Two other terms are 

used extensively in the parameter screen explanations in the chapters to follow. These are 

checkboxes and radio buttons.

Checkboxes are the little square shaped areas located beside a particular option. The setting 

they are referring to is switched on (selected) by left-clicking in the box which will then 

display a tick to indicate it has been selected. They are switched off by clicking in the box 

again and the tick disappears. Checkboxes are associated with items where more than one 

selection can be made, for example when selecting regions or spatial cells for display in the 

Catch by Weight results menu option. 

Spatial Cell Selection 

r ',_ · C,u 

[j Spatial Cel 1 

r Spatial Cel 2 
r Spatial Cel 3 

r Spatial Cel 12 

r Regional Zones 
f.'. Jlndivirual � 

r ·,�. ,..,,, G1.,f 

r Spatial Cel 4 

C Spatial Cel 5 

r Spatial Cel 6 

� Aggregate Spatial Cels 

r G, I ,t I ro�e ' 

C Spatial Cell 7

C Spatial Cell 8 

C Spatial Cell 9 

r Spatial Cell 10 

r Spatial Cell 11 

Radio buttons (little circles) are also clicked in when choosing screen settings, but differ in that 

they are used when your choice is limited to one option only. They do not operate on an 

on/off basis like the checkboxes, rather you click on the option you want and that will 

automatically switch off the previous selection. For example, they are used when selecting 

whether data is to be displayed as either aggregated or by individual spatial cells. They are 

also used in the Stock-Recruitment results screen for the selection of region for display, as 

unlike the other results screens, stock-recruitment can only be displayed one region at a time. 

r. Aggregate r Individual 

r. West Coas� r ,S_pencer Gulf r St. Vincent Gulf 
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1.2.2. Getting Started 

1. To start WhitSim, go to Start I Programs I WhitSim and click on the WhitSim icon. The

"South Australia King George Whiting Management Model" window will appear.

2. The Parameters and Strategy menus can be used to change parameter values and alter

management strategies, described in chapters 5 and 6. The model is run by clicking the

Simulate menu option and choosing Run Overlay Model from the resulting dialog box.

3. The Results menu is used to display the model output resulting from the chosen strategy.

The results are represented by time plots ( catch-by-weight, legal size biomass, egg

production, recruitment and fishing mortality rate), catch-at-age histograms, and stock­

recruitment The baseline scenario, before management is imposed, is automatically

loaded and can be displayed for comparison with the management strategy.

4. Each time the model is re-run, with new parameter values or a new management strategy

that you want to be able to re-use in the future, you can save the output and all input

parameters as a new project. To do this click on the Save speed button, or select Save

As ... from the File menu, which will bring up the Save WhitSim Project dialog box.

Type in the new project name of your choice making sure to type in the .pro extension to

any project name chosen. Click OK to save this new project.

5. If users wish to re-open a previously saved project, select FilelOpen Project and click on

the appropriate project name, or select FilelNew Project to start a new project. When a

project is loaded its name appears in the Model title bar.

4 
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2. Using Menu Commands

2.1. Menu Bar 

The Menu Bar is located below the title bar, along the top of the application window, and 

contains all of the WhitSim commands. 

2.1.1. Choosing a Menu Command 

You can choose commands with the mouse or by pressing key combinations. 

Mouse: 

1. Point to a menu name.

2. To display the menu, click the left mouse button.

3. Point to a command name/menu item.

4. Click the command name with the left mouse button.

Keyboard: 

1. To display a menu, hold the ALT key down and press the underlined letter in the menu

name.

2. To choose a command, press the underlined letter in the command name.

2.2. Dialog Boxes 

Selecting an item from the main menu will automatically open a WhitSim dialog box. For 

example, selecting Legal Minimum Length from the Strategy menu will cause the Legal 

Minimum Length dialog box to be displayed. When a dialog box is opened, any previously 

altered information will be displayed. If no information has been changed then the default 

settings are shown. Any changes you wish to make to the values shown are done within the 

dialog boxes. Options which appear in grey cannot be changed. 

2.2.1. Moving a Window/ Dialog Box 

You can position document windows and dialog boxes anywhere in the application window. 

For example, you can move and size two graphic windows so they appear side by side as you 

work. However, you cannot move a window that has been enlarged to its maximum size. 

To move an application window or dialog box point the mouse to the title bar of the window 

or dialog box and drag it to the new position. 

2.2.2. Setting Dialog Box Options 

To make any changes to dialog box options: 

1. Use the mouse to click in the window or button of the desired item, or use the TAB key

to move through the options until you reach the item you are interested in.

2. Make your changes either by typing in new values where relevant or clicking the left

mouse button to switch checkboxes on or off or to choose from a list of options.

5 
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3. If you have changed the values in the dialog box you will need to click on a Set Values

button to submit these values.

4. To confirm your changes and exit the dialog box click on the OK button.

To cancel changes to options settings: 
1. In all WhitSim dialog boxes there is a Set Defaults button, which will cancel any

changes made and restore the default values.

2. Alternatively, clicking on the Cancel button will disregard any changes made and exit

the dialog box. Cancel will only apply to changes made while the dialog box is open -

it will not cancel any previously saved changes.

2.2.3. Closing a Dialog Box 

In summary, dialog boxes can be closed in three ways: 

1. click the OK button, which will save any changes made during the session;
2. click the Cancel button, which cause all changes made during the session to be

cancelled and the default or previously saved information to be re-installed.

3. click the Close button at the top right of the window, which cause all changes made

during the session to be cancelled and the default or previously saved information to be

re-installed.

2.3. Window Menu 

The Window menu allows the user to control the layout of the windows on the screen. The 

menu includes commands to arrange and close windows. The five menu options are described 

below: 

The Cascade command stacks all open edit windows so each is the same size as all others and 

only part of each underlying window is visible. 

The Tile command arranges the open windows so they cover the entire model display area 

without overlapping one another. 

The Arrange Icons command leaves icons evenly spaced, beginning at the lower left comer of 

the model display area. All open windows must be minimised or this command is disabled. 

To reduce all open windows to buttons on the taskbar, choose Minimize All. 

The Close All Windows command closes all open windows in the model display area. If text 

was modified since the last time you saved it, a dialog box will open asking if you want to save 

the file before closing the window. 

6 
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3. Working with Projects

3.1. Projects 

The data for any management strategy, both the regulations you choose, and any other 

parameters you change, together with all outputs from the overlay, can be stored for later use. 

This collection of inputs and outputs is called a "project". The files containing each project 

end with a ".pro" extension. You choose the Windows project filename so that the full name, 

for example, might be "mypolicy.pro". 

The "baseline" project contains the model's reconstruction of the history of the fishery. The 

file, "baseline.pro", is stored in your model subdirectory, and will be automatically loaded with 

the model. When you then impose a new management policy that you'd like to test and run, 

the plots for the outcomes from your tested fishery regulation are overlayed with the results of 

the baseline run for comparison. This allows you to see whether the newly tested policy 

enhances catch, egg production and recruitment. 

3.2. File Menu 

The File Menu includes commands that enable you to create a new project, open and close 

existing project files, save created projects and provides you with a means to print graphs and 

reports as well as exit the package. In this section we will describe the functions of the File 

menu commands. 

3.2.1. Open Project 

To open a previously saved project, choose Open from the File menu or click on the Open 

speed button. A dialog box will appear displaying all of the previously saved projects in the 

WhitSim directory. If you have saved your projects in a different directory you will need to 

browse to that directory to view your files. Click on the file you wish to open and click on the 

Open button. The name of the open project will appear in the title bar of the WhitSim 

window. 

3.2.3. Save Project 

You can save your project at any time by choosing Save or Save As ... from the File menu, or 

by clicking on the Save speed button. This will bring up the Save WhitSim Project As dialog 

box. It is recommended that you choose an alternative directory from the default WhitSim 

directory to save your project files. This will prevent them being overwritten if the model is 

re-installed at a later time. From this Save As dialog box, browse to a directory where you 

will save all your WhitSim files. Type in the name of the project in the File Name window 

making sure to type in the .pro filename extension (eg, strategyl .pro) and click on the Save 

button. It is important to type in the .pro extension otherwise the project will not be displayed 

when you go to open it at a later time. If you later make further changes you'd like to keep, 

click on the Save speed button and click on the relevant project in the list below to re-save 

under its current name and location. 

7 
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3.2.3. Save As 

When you are saving a previously unsaved new project, choosing either Save or Save As ... 

from the File menu, or the Save speed button will display the Save WhitSim Project As 

dialog box prompting you to give it a name. After a project has been saved, subsequent Save 

commands will update the project under it's existing name. The Save As ... command, 

however, always displays the dialog box allowing the user to make a copy of an existing 

project file by saving it under a different name. 

3.2.4. Closing Projects 

While there is no specific command to close the active project, there are three implicit ways to 

leave a project: if you choose Exit, Open Project or New Project the present project will be 

closed or replaced. It is recommended that you save changes to your project before leaving it; 

if a project is closed without being saved, you will lose all changes made since the last time it 

was saved. 

3.2.5. Baseline Projects 

The baseline scenario is the model's reconstruction of the history of the fishery. It is not 

anticipated that users will need to alter the baseline parameters. However, you may, if you 

choose, create a new baseline scenario based on a different set of parameter values. The most 

recently saved baseline scenario will automatically load when WhitSim is opened and will 

remain as the baseline until a new one is saved or the WhitSim default is restored. 

3.2.5.1. Saving a new Baseline 

To save a new baseline scenario: 

1. Make changes to the parameter values as described in Chapter 5.

2. Click on the Simulate menu which will bring up a dialog box.

3. Select "Run Baseline Model" mode by clicking on the radio button next to this option.

4. Run the model by clicking on the Execute button. Note that there is a few seconds

delay before the progress meter begins moving.

5. To save the new baseline, select Save Project as Baseline from the File menu. An

information box will appear asking if you want to overwrite the baseline project. Click

on Yes.

Your newly saved baseline project will appear in all future overlays as the baseline comparison 

and will be automatically loaded when WhitSim is opened. 

3.2.5.2. Reset Default Baseline 

If you wish to reset the baseline project back to the WhitSim default, select Reset Default 

Baseline from the File menu. An information box will appear asking if you want to overwrite 

the baseline project with default values. Click on Yes. Resetting the default WhitSim baseline 

is a means of removing all changes you have made and returning to the default settings. 

3.2.6. Printer Setup 

The Printer Setup command in the File menu displays the Print Setup dialog box. This 

displays the printer properties such as page orientation, scaling, paper size, paper source and 

number of copies printed for the printer chosen as the default. 

8 
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3.2.7. Generate Report 

Reports are (ASCII) text files that can be opened and viewed in text editors, word processors 

or spreadsheets. The Generate Report menu option, under the File menu, gives you access to 

all the reports, and allows you to choose which of them to include in a complete file summary 

of the model project you presently have open. This same Report Generation dialog box is 

also immediately accessible at any time by pressing the Report speed button. Alternatively, 

clicking on the "Create Report" button from any of the Parameters or Strategy menu option 

windows will produce a report for those data. The report will appear on the screen in a text 

editor from which you can type in additional comments or information and edit the file using 

the Edit menu. The Generate Report command allows model parameters, management 

regulations, and the resulting model outputs to be exported to other Windows applications. 

To create a report: 

1. Select Generate Report from the File menu, or click on the Report speed button. This

will display the Report Generation dialog box.

2. Model results can either be reported on a yearly or monthly time scale. Click on the radio

button corresponding to the time scale you wish your variables to be reported in. The list

box contains all of the variables that can be reported in the selected time scale. Click on

the variable you are interested in and click the Add button to move it into the Selected

Variables list box. Double-clicking on the variables will also select the variable.

Total Exploitable Population 
Fishing Mortalit_y Rate [F) 
Egg Production 

Legal Size Biomass 

3. Select the data to be displayed:

(a) by Region:

i) To select data from one or more regions, click on the Regional Zones radio button.

ii) Choose the regions whose data you wish to display by clicking in the checkbox

alongside the particular region(s).

9 
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iii) If you have selected more than one region for display and want your selected model

output to be aggregated (i.e. summed), click in the Aggregate Spatial Cells

checkbox. If this checkbox is not selected data will be displayed for each region.

(b) by spatial cell:

i) To display the data by individual spatial cell, click on the Individual Cells radio

button.

ii) Choose the spatial cells you wish to display by clicking in the checkbox alongside

the particular spatial cell(s).

iii) If you have selected more than one spatial cell for display and want your selected

model output to be aggregated, click in the Aggregate Spatial Cells checkbox. If

this checkbox is not selected data will be displayed for each spatial cell.

Regional/ Spatial Cell Selection [j Aggregate Spatial Cells 

r. Regional Zones r Individual Cells 

17 tvJest_'coas� 

� •. pdlidf Leif 1
� "pdt,af 1..elf 2
P' "'Pd 1al V·II 3
P' .:i pattdl ..ell 12

r Spencer Gulf O Gulf St. Vincent r Other Cells 

r ;;pditdl Cell 4 
r ",pdttc1f Ct::11 5 
r ':paltal Cell b 

r .;ipatfal Cell 7 
r ' pdl1al Cell 8 
r Pdlid1Cell9 
r :,pat1al Cell 10 
r pdhdl efl 11 

w Baseline Data J 
4. If an overlay scenario has been run, both baseline and overlay data can be reported. If no

strategy has been run yet, only the baseline data is available for display and the overlay

data option is disabled.

5. Model parameters and data associated with the current fishing strategy can also be

displayed on a yearly time scale. Select any of these parameters by clicking in the

checkbox next to those you would like data reported for.

Model Parameters 

C !;atchability r Adult Migration n flecruitment C �pawning 

Fishing Strategy 

� l,egal Minimium Length r .Quota and Closures r Historical Effort 

3.2.8. Exit 

To quit WhitSim, either 

1. from the File menu, choose Exit with the mouse (or optionally, ALT + F, X on the

keyboard), or

2. click on the Exit speed button, or

3. click the Close button at the top right of the WhitSim window.

10 
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If you have made changes to your active project since you last saved, then you should use the 

FilelSave option before leaving WhitSim, or all changes will be lost. 

11 
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4. Data Menu

4.1. Spatial Cell Map 

The King George whiting model simulates the fishery by month in 13 spatial cells. Selecting 

Map from the Data menu graphically displays the coastal zone of the King George whiting 

fishery in South Australia. The spatial cell map allows the user to view the three major King 

George whiting fishery regions and their division into spatial cells for used by the WhitSim 

Management Model. 

Regions can be displayed by clicking the left mouse button in one or more of the checkboxes. 

For example, to display the region labelled "West Coast", click the checkbox along side that 

region's label. This will result in spatial cell 1, spatial cell 2, spatial cell 3 and spatial cell 12 

becoming highlighted on the map. To display an individual spatial cell, click the left mouse 

button over one of the spatial cell labels. For example, to display the Spatial Cell 4, click the 

label marked "Spatial Cell 4". 

4.2. Catch and Effort Data 

One of the three principal data inputs to the model are the totals of catch and fishing effort by 

month, in each cell, and for each fishing effort gear and target type. Selecting Catch and 

Effort from the Data menu graphically displays the catch and effort data used in the 

simulation. 

12 
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4.2.1. Displaying Data 

To graphically view the catch and effort data to which the model was fitted, users should 

follow the steps below. 

1. Select the type of data to be displayed: Catch or Effort, by clicking on the corresponding

radio button.

2. Select the data to be displayed:

(a) by Region:

i) To display the sum totals of catch or effort by month in one or more regions, click

on the Regional Zones radio button.

ii) Choose the regions you wish to display by clicking in the corresponding
checkbox( es ).

iii) If you have selected more than one region for display and want your selected

regions to be aggregated into a single line plot, click in the Aggregate Spatial

Cells checkbox. If this checkbox is not selected a separate line plot will be

displayed for each region.

(b) by spatial cell:

i) To display the data by individual spatial cell click on the Individual Cells radio

button.

ii) Choose the spatial cells you wish to display by clicking in the checkbox for those

spatial cell(s).

iii) If you have selected more than one spatial cell for display and want your selected
spatial cells to be aggregated into a single line plot, click in the Aggregate Spatial

Cells checkbox. If this checkbox is not selected a separate line plot will be

displayed for each spatial cell.

3. Data can also be displayed according to gear type. The gear type panel lists the different

gear type selections.

(a) Click the checkbox(es) along side the gear type(s) to be displayed.

(b) The data will be displayed aggregated across the selected gear types if the Aggregate

Gear Type checkbox is switched on, otherwise the data will be displayed as a separate

line plot for each gear type selected.

4. To display the selected data or to update the plot after changing the data selection, click on

the button labelled Update Graph.

The following figure shows an example of the Catch and Effort data screen with the options 

selected and resulting graph of catch data for West Coast and Spencer Gulf (displayed 

separately) for haul net captured fish only. Note that in this example only one gear type has 

been selected so it doesn't matter whether the Aggregate Gear Type option is switched on or 

off.· 
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�Catch and Ello, I Data 
---

l!llill:J 

J2 ]Jpda!e Graph I r. .Catch Data r Effort Data 

Catch/Effort �ar Type 

J 
Spatial Cell Selection r. Regional Zonei C Aggegate Spatial Cells 

r I ndividt.181 Cells 

w' We.tCoasl (;; Spencer Gil r Guf SL Viicert 

5 

6 

4.2.2. Printing the graph 

(;; Aggregate Gear Type 

r: Handine 
r.; Haunet 

r: Gilnet 
r Olher 

[J Fj-ecr-ealional
,,...._ -,,I 

To print the displayed graph click on the button marked Print Graph. 

4.2.3. Enlarging the Graph 

� Deale Report 

� !;_nlarge G111Ph 

lL Qoie ? !:!9".> 

Clicking the button marked Enlarge Graph creates a copy of the graph which can be enlarged 

to the desired size by dragging the corner of the graph or to it's maximum size by clicking the 

maximise button at the top right of the window. Close this copy of the graph by clicking on 

the close button at the top right of the window. 

4.2.4. Creating Reports 

Pressing the button marked Create Report will open a text file containing the displayed data. 

This file can be saved if desired by selecting Save from Notepad's file menu. To close the 

report file click Exit from Notepad's File menu or click on the close button at the top right of 

Notepad's window. 

4.3. Catch Likelihood Standard Deviation 

Catch likelihood standard deviations were produced as part of the WhitSim Estimator. The 

matrices displayed in this data window are purely for information purposes. The likelihood 

standard deviations are not used in the simulator. 

14 
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Displaying Likelihood Standard Deviations: 

1. There are two likelihood standard deviation matrices: the first is between July 1976 and

June 1983; and the second is between July 1983 to present time. To select between the two

matrices press the radio button associated with the time period of interest.

2. If the July 197 6 to June 1983 option is selected the targeted species menu is greyed out and

the matrix of standard deviations is displayed. If the July 1983 onwards option is selected

an additional radio button menu becomes active. The matrix of standard deviations

displayed will depend on which target species option you choose from this menu. The

three options are:

(a) specifically targeting whiting,

(b) specifically targeting species other than whiting, and

( c) not specifically targeting any particular species.

3. Once a selection has been made a matrix of likelihood standard deviations is displayed.

The displayed matrix shows values for each gear type for each spatial cell. The example

below illustrates the layout of the likelihood matrix.

15 
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5. Parameters Menu

The Parameters menu allows you to view and/or change any model parameters as explained 

below. Normally, however, it will not be necessary to change parameters. The simulation will 

automatically employ default values if no new parameters are chosen. The default values have 

been estimated from the following data from the fishery: 

1. tag-recaptures for movement,

2. fisher-reported commercial catch and effort totals by gear and target type, and

3. otolith-derived numbers of fish captured by age.

The approximately 500 default parameters already loaded into baseline and overlay 

simulations were derived from a rigorous likelihood data fit (using AD Model Builder). It is 

unlikely therefore that the user can guess more appropriate values. However, to test for the 

sensitivity to the other possible choices, the user can change any parameters of the model using 

the screens in this menu. 

5.1. Catchability Parameters 

Catchability parameters quantify the relative catching power of different effort types. When 

fishers provide monthly catch and effort totals, they indicate the fishing gear used and what 

fish species they targeted each day. Each possible combination of effort gear and target type 

thus represents a different capability of catching King George whiting per fisher-day on the 

water. 

The catchability parameter screen is divided into two sections: catchability by gear type, and 

male selectivity. 

5.1.1. To edit Catchability by gear type 

1. Select the catchability time period. There are two options: July 1976 to June 1983, and

July 1983 onwards. Target species was not collected on catch and effort forms prior to

July 1983, thus no target type is available for those years. If the July 1976 to June 1983

option is selected the target type menu is greyed out and the catchability for each of the

five gear types is displayed. If the July 1983 onwards option is selected the target type

menu becomes active. The catchabilities displayed will depend on which target species

option you choose from this menu. The example given below indicates that the

"specifically targeting whiting" catchabilities are to be displayed.

16 
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2. To edit a catchability, highlight the existing value with the mouse and type in a new value.

3. Clicking on the Set Defaults button will restore all default values. Clicking on the

Restore Values button will reinstate your changed values.

5.1.2. To Edit Selectivities 

There are two ways to edit selectivity parameters: 

1. Male Selectivity (relative to females), and

2. Monthly selectivities February to December (relative to January).

To edit any of the values, highlight the selectivity to be edited using the mouse and type in the 

revised value. Clicking on the Set Defaults button will restore all default values. Clicking on 

the Restore Values button will reinstate your changed values. 

5.2. Adult Migration Parameters 

An important feature of King George whiting life history is their movement in the two Gulfs, 

in particular the migration of adults from predominantly inshore areas in the northern regions 

out to spawning grounds in the southern Gulfs. The adult migration parameter screen controls 

the proportion of whiting that migrate between spatial cells on the assumed yearly time of 

17 
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summer migration, January 1 of each model year. There are essentially two migration 

matrices: one for whiting aged 33 months and a second for whiting aged 45 months, which 

also applies for older ages. 

The migration parameter screen also displays the assumed whiting natural mortality rate and 

the migration proportions for whiting moving from the West Coast spatial cells to offshore 

spawning regions. 

5.2.1. To edit Natural Mortality 

To edit the natural mortality rate: 

1. Place the cursor in the Natural Mortality edit box and highlight the current value.

2. Type in the new value.

3. Clicking on the Set Default button will restore the default value. Clicking on the

Restore Value button will reinstate your changed value.

5.2.2. To edit Migration Matrices 

1. Select either the "migration at age 33 months" or "migration at 45 months" radio buttons.

2. Once selected, the specific matrix will be displayed. The example below shows the

migration portion of the parameter screen and the default matrix for the migration at 45

months option. Each parameter in the table gives the migration proportion From the

spatial cell indicated by the column, To the spatial cell numbered by row. Consequently

users must ensure that all the proportions in each column sum to 1, since on January 1 of

each model year, the fish must stay in their spatial cell (To = From) or move to one of the

others.

18 
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11 

11 

11 

Migrotion 

2 

3 

4 

To 6 

· Spatial
7 

Cell

10 

11 

12 

13 

-- -- -

Migrn.tion 

Check Sums 

r Mig:ation at age 33 months Migration Proportion 

r. Mig:ation at age 45 months 10.089 Set Values Set Delauks I Re t, re 'al;;_ I 

From Spatial Cell 

1 2 3 4 5 6 7 B 9 10 11 12 13 

0 0 0 0 0 0 0 0 0 0 0 0 

I ---

0 D 0 0 0 0 0 0 0 0 0 0 

D D 0 0 0 0 0 0 0 0 0 0 

D D 0 0.911 0 0.421 0 0 0 0 0 0 0 

0 0 0 D 0.034 0 0 0 0 0 0 0 
-- ..........

0 0 0 0.089 0 0.545 0 0 0 0 0 0 0 

l 0 0 0 0 0 0 0.101 0 0 0.26 0 0 

0 0 0 0 0 0 0 0.899 0.345 0.54 0.125 0 0 Ii 
0 0 0 0 0 0 0 D 0.655 0.23 0.246 0 0 

---

0 0 0 0 0 0 0 D 0 0.23 0 0 0 

Ii 0 0 0 0 0 0 0 0 0 0 0.369 0 0 
I: 0 0 D 0 0 0 0 D 0 0 0 0 ' 

0 D D 0 0 0 0 D 0 0 0 0 
J 

rrrrrrrrrf1""Jr,-icL: 
Note: For valid mig:ation matriK colur111s must sum to 1. 

3. To edit any of the migration values:
(a) Click the mouse on a migration value in the matrix. The example above demonstrates

that the value for whiting migration from spatial cell 4 to spatial cell 6 has been

selected.

(b) The migration value is automatically copied to the "Migration Proportion" edit box,

located above the matrix. To change the value of the migration value highlight the

value in the edit box and type in the new value.

( c) Save the changed migration value by clicking the button labelled Set Values, located to

the right of the edit box.

( d) Change any other migration values from that spatial cell to ensure the column sums to
one. Make sure to click Set Values each time you enter a new value.

Clicking on the Set Defaults button will restore all default values. Clicking on the 

Restore Values button will reinstate your changed values. 

5.2.3. To Edit Migration from the West Coast 

Because no tags have ever been recovered from West Coast spawning grounds, the rates of 

movement from inshore to offshore in these cells were inferred from the catch data alone. The 

West Coast region comprises spatial cells 1, 2, 3, and 12. Therefore, migration away from the 

West Coast is described by four migration rates, one for each spatial cell. Incorporating the 

two age classes of whiting considered in this model, results in two sets of four parameters that 

control the migration away from the West Coast. One set is for whiting at age 33 months and 

the other is for whiting at age 45 months (see figure below). 
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To change any of these parameters, highlight the value in the edit box associated with the age 

and spatial cell to be changed and type in the new value. Clicking on the Set Defaults button 

will restore all default values. Clicking on the Restore Values button will reinstate your 

changed values. 

5.3. Recruitment Parameters 

"Recruitment" in this model is defined as the number of 1-year-old fish spawned the year 

before, in each spatial cell. Each of these recruitment values were obtained as estimates from 

the data described above. The recruitment parameter screen displays the input recruitment 

values for each spatial cell over the simulation time period. The example below illustrates the 

recruitment values for the Gulf St. Vincent spatial cells. 

5.3.1. Displaying and editing Recruitment Parameters 

1. Select the data to be displayed:

(a) by Region:

i) To display one or more regions, click on the Regional Zones radio button.

ii) Choose the regions you wish to display by clicking in the checkbox alongside the

particular region(s).

iii) If you have selected more than one region for display and want your selected

regions to be aggregated into a single line plot, click in the Aggregate Spatial

20 



l 

n 

n 

n 

0 

n 

I I 

fl 

11 

I J 

l l 

lJ 

l 1

n 

u 

u 

u 

u 

u 

SA King George Whiting Management Model 

Cells checkbox. If this checkbox is not selected a separate line plot will be 

displayed for each region. 

(b) by spatial cell:

i) To display the data by individual spatial cell, click on the Individual Cells radio

button.

ii) Choose the spatial cells you wish to display by clicking in the checkbox alongside

the particular spatial cell(s).

iii) If you have selected more than one spatial cell for display and want your selected

spatial cells to be aggregated into a single line plot, click in the Aggregate Spatial

Cells checkbox. If this checkbox is not selected a separate line plot will be

displayed for each spatial cell.

2. Recruitment can be displayed as either a continuous time series plot for each spatial cell

selected or as a bar chart with yearly recruitment displayed for each spatial cell. Use the

radio button under the label "Display Type" to switch between these display modes. Note

that if the "Time Series" display type is selected, only the spatial cells that have been

selected will be displayed (for all years), but if the "Spatial Cell" display type is selected

all spatial cells will be displayed, but only for the year that the year slider located above the

recruitment edit box is set to.

3. When editing recruitment values it is recommended that the Individual Cells option be

selected and that data is displayed in the Time Series format. Any new value entered will

apply to each spatial cell selected in the Spatial Cell Selection portion of the screen.

To change the recruitment value:

(a) Move the year slider to the year in which the change is to be made;

(b) Highlight the current value in the edit box and type in the new recruitment value;

( c) Click on the "Set Value" button to confirm the change. The graph will automatically

update all spatial cells displayed with the new value.

4. The new recruitment value will be applied every year from the selected year to 1995.

Later years can be scrolled to and changed in the same way, remembering to click on the

Set Value button for each change. Clicking on the Set Defaults button will restore the

default values. Clicking on the Restore Values button will reinstate your changed values.
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5.4. Spawning Parameters 

The spawning parameter input screen displays the spawning data used in the simulation to 

calculate the number of whiting spawned in each of the spatial cells. 

Parameters that control whiting spawning are: 

1. Proportion of females actively spawning
2. Average number of egg releases per autumn spawning season

3. Youngest age (months) the King George whiting females can bear eggs

4. Slope parameter for batch fecundity regression

5. Intercept parameter for batch fecundity regression.

Spewing Parameters 

SpatialCell � = 4 

11 Proportion of females actively spawning 
:======= 
134.3 Average nurroer of egg releases per auturm spawning season 
:====== 

137 Youngest age the Kng George whitirg females can bear eggs 

1936.47 Slope parameter for batch fecundity regression 
.:=========-= 
1_·3_14_

6
_
17

_
.2 __ ...J' Intercept parameter for batch fecundity regression 

�OK )( Cancel I
__ ?_.l:i_elp _ __, 

It is important to note that values can only be edited if the "proportion of females actively 

spawning" has a value greater than 0. For some (primarily inshore or upper Gulf) spatial cells, 

the default value is zero because no females are observed to spawn in these areas. 
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6. Strategy Menu
This is the most important menu for use of this model as a management tool. The Strategy 

menu allows you to select the fishery management policies that you choose to test. Five basic 

forms of regulation can be imposed on this simulated fishery: size regulations (legal minimum 

length), quota, space closures, time closures, and effort controls. 

The basic procedure for simulating the effect of alternative management regulations is a 'What 

if?' scenario test. The screens described below allow the user to choose or add different 

regulations to those in effect over the historical years of the simulation. The user also specifies 

the specific historical year when these new alternative regulations are to be imposed. Once 

these user-chosen regulations are run (using the Simulate menu), the outputs will be displayed 

as 'Overlay' plots in the Results menu. 

6.1. Legal Minim um Length 

The Legal Minimum Length (LML) parameter screen displays the LML values used as input 

into the model over the entire whiting fishery. The default values illustrated below show that 

the minimum length above which King George whiting could be legally landed rose from 

280mm to 300mm in September 1995. 

,..... 320 ' = - - � - - -1 - � - J. -- - � - _J - - - .. - = - - � _ -' _ � � = ______ .1. ______ ..J ___ ,L __ _ 
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Select Year lndeK 
1983d_j-

Year: 1983 

� Create Report 

m 0 ai N (Y) 
to 0) 0) 0) 

'5. '5. -a. '5. '5. 
Q) Q) Q) Q) Q) 
Cl) Cl) Cl) Cl) Cl) 

Ye�rs 

� 1998 
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r. 280 mm

r 290mm

r 300mm

r 310mm

r 320mm

'Of" U) (D 
0) 0) 0) 

'5. -a. '5. 
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(I) Cl) Cl) 

Set Values 
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Alternative minimum size strategies can be tested by changing yearly LML values, running the 

model with the new values and graphically comparing the results with this historical regime. 

To edit legal minimum length values 

1. Use the scrollbar to select the year from which LML is to be set. This can be done by

clicking on the arrow at the right of the scrollbar until you reach the desired year, or by

dragging the scrollbar with the mouse to the desired year.

2. Once a year has been selected, set the LML value by clicking on one of the five options;

270mm, 280mm, 290mm, 300mm or 310mm.

3. Click on the Set Values button to confirm the new LML value. The graph will update

automatically after clicking the Set Values button. The value you choose will apply for

the selected year and all subsequent years.

4. Later years can be scrolled to and changed in the same way, remembering to click on the

Set Values button for each change.

5. Clicking on the Set Defaults button will restore the default values. Clicking on the

Restore Values button will reinstate your changed values.

6.2. Quota and Closures 

This parameter screen displays the Quota and Closures fishing regulations for each of the 

fishery's spatial cells for each year of the simulation. 

6.2.1. Quota 

A quota represents a fixed upper limit on yearly catch. In the simulation this is achieved by 

simply turning off fishing in any cell and year where the quota has been reached. The quota 

parameters are written in such a way that they specify the quota as a fraction of the historical 

average catch in each cell over the years of the simulation. The default value for quota 

parameters is "l", inferring they are set to normal boat limit values. A quota value of "2" 

indicates that limits are doubled and a value of "0.5'' indicates that limits are halved. In order 

to turn quota off, click on the "No Quota Set' button. 

To edit Quota values: 

1. Use the scrollbar located at the top of the quota parameter screen to set the year from

which quota is to be set. In the example below the year is set to 1985.

2. Once the year is set, type the new quota values into the edit boxes for the spatial cells you

wish to change. In the example below the quota in spatial cell 4 has been doubled,

allowing twice as many fish to be caught from this spatial cell.

3. The new quota values for each of the spatial cells will be applied every year from the

indicated year to 1999.

4. Later years can be scrolled to and changed in the same way.

5. Clicking on the Set Defaults button will restore the default values for all years that have

been changed. Clicking on the Restore Values button will reinstate all of your changed

values.

6. Exiting this screen by clicking OK will save all changes made.
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6.2.2. Seasonal and Spatial Closures 

Closures can be set for any spatial cell and month of every simulation year ( 1983 - 1999). 

To set Seasonal and/or Spatial Closures: 

1. Use the scrollbar associated with the Seasonal Closures portion of the screen to set the year

from which closure is to be set. In the example below the year is set to 1983.

2. The default scenario is that the fishery is open to fishing in all months for all spatial cells.

(a) To close specific spatial cell/month combinations to fishing, click the checkbox

corresponding to that spatial cell and month. See arrow (a) on the figure below.

(b) To impose a spatial closure on any cell, i.e. to close a particular spatial cell for all

months of the year, click on the checkbox immediately to the right of the spatial cell

label. See arrow (b) on the figure below.

(c) To close all spatial cells for a particular month of the year, click on the checkbox

immediately below the month label. See arrow (c) on the figure below.

Play around with this screen, opening and closing cells to fishing until you achieve

your desired strategy.

3. Click on the "saveclosures" button under the scrollbar to submit your settings for the

selected year and all subsequent years.

4. Later years can be scrolled to and changed in the same way, remembering to click on the

saveclosures button for each change.

5. Clicking on the Set Defaults button will restore the default values. Clicking on the

Restore Values button will reinstate your changed values.

In the example below, spatial cells 2, 3 and 4 have been closed for all months of the year, all 

spatial cells have been closed to fishing in October, and spatial cell 10 has been closed to 

fishing in April. All of these closures will be set from 1983 to 1999. 

Seo.sonal Closures P' Indicates an OPEN Season 
Set Defaults I Restore Values1983 1983 1999 r Indicates an CLOSED Season 

(c) • ii Jui Aug Sep Oct Nov Dec Jan Fe un 
saveclosures w p- p- 14 .,; w w w � w w 

Spatial Cell 1 w w w w r w w w w w 

Spatial Cell 2 C C r: C r r r r r r 
(b) r r r r r r r r r r 

Spatial Cell 4 C C C n r r r r r: r 
Spatial Cell 5 w w w M r w w w w w 

Spatial Cell 6 � � w � r w w w � w 

Spatial Cell 7 w w w w r w w w w w 

Spatial Cell 8 w w � � r: w w w w � 
Spatial Cell 9 w w w w r M w w w w 

Spatial Cell 10 w w � � r: R: w w w w 
Spatial Cell 11 w w w w r w w w � w 

Spatial Cell 12 w w w w C � � � � w 

Spatial Cell 13 w w w w r w w w w w 
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6.3. Effort Controls 

This menu option provides you with a means of controlling the number of boat-days that are 

fished per month in the King George whiting fishery. These are expressed as a proportion of 

the reported historical baseline effort values shown in the Catch and Effort screen under the 

Data menu. 

Effort can be edited according to one or more gear types: 

1. Select the gear type or combination of gear types for which effort is to be altered. This is

done by clicking in the checkboxes associated with the gear types.

2. After selecting the gear type(s), use the scrollbar to select a year from which effort is to be

changed.

The example below indicates that handline and haul net effort have been selected for change 

commencing in 1987 and remaining in all subsequent years through to 1999. 

Effort Matrix Geortype 

� Handline � Haul net D Gill net

C Other r Recreational

Select Year lndew 
1983 4 � 1999 

Year: 1987 

3. Select the spatial cells and/or months you wish to change the effort proportions by clicking

in the checkbox( es) associated with the spatial cells/months. Individual spatial cells are

selected by clicking in the checkboxes to the right of the spatial cells or regions can be

selected by clicking in the checkbox( es) located below the matrix.

In the example below, spatial cells 2 and 5 for months March and October have been selected. 

C 
Check all 

Months 

Spatial Cell 1 r 
Spatial Cell 2 p 

Spatial Cell 3 r 
Spatial Cell 4 
Spatial Cell 5 p 

Spatial Cell 6 r 
Spatial Cell 7 
Spatial Cell 8 r 
Spatial Cell 9 r 
Spatial Cell 10 C

Spatial Cell 11 r 
Spatial Cell 12 r 
Spatial Cell 13 r 

1 
1 

1 
1 
1 

1 
1 
1 

1 
1 
1 
1 
1 

Effort Matrix 
Jan Feb Mar Apr May Jun Jui Auci Sep Oct Nov Dec 
r r w � r r r r r � r r 

1 1 1 1 1 1 
1 1 1 � 1 1 1 -- _.I 

1 1 1 1 1 1 
1 1, 1 1 1 I , 
1 1 1 1 1 1 

--

1 1 1 1 1 I , 
1 1 1 1 1 1 
1 1 1 1 1 11

- -

1 I 1 1 1 11 
1 I , 1 1 1 1 
1 , 1 1 1 1 --
1 1 1 1 1 1 
1 1 1 1 1 1 � 

1 1 1 
1 1 , 

1 1 4 

1 1 1 

1 1 ,

1 1 , 
j 1 1 1 

1 1 1 

1 1 , 
1 1 1 

1 1 1 

1 1 1 
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4. Enter the new value in the edit box below the matrix. This will be a proportional change
so a value of 2 will double the effort and a value of 0.5 will halve it.

5. Click on the Set Values button and the values will automatically be updated in the matrix.
Note that values will be set from indicated year until 1999.

6. Later years can be scrolled to and changed in the same way, remembering to click on the
Set Values button after each change.

7. Clicking on the Set Defaults button will restore the default values. Clicking on the
Restore Values button will reinstate your changed values.

The screen below shows the changes made described in this example. 
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7. Running WhitSim
After a management strategy has been selected, the model can be executed by following these 

steps: 

1. click on the Simulate menu. This will cause the simulation window to be displayed.

There are two modes in which the simulation can be executed: Baseline and Overlay. The 

only time you would ever need to run the model in baseline mode is if you want to save a new 

baseline scenario as described in Section 3.2.5.1. For the occasions in which you are testing a 

new management strategy, always run it in Overlay mode. 

2. click on the radio button corresponding to Overlay mode.

3. Run the model by clicking on Execute (once). Note that there is a few seconds delay

before the progress meter begins moving.

If at any stage you wish to exit this screen without running the model, click on the Cancel 

button. Once the model is executing it cannot be stopped by the user and will terminate when 

the simulation is completed. 

The model results with the new regulations ( or parameter values) will appear in the graphs 

with the option of overlaying them with the baseline scenario for comparison. 

With each model run, the previous overlay run will be replaced. If you wish to save the 

previous model run, do so before changing any parameters or imposing new regulations. 
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8. Results

8.1. Strategy Time Plots 

The principal model outputs for testing fishery management strategies are the time plots. 
These present the yearly levels of four critical variables for managing the King George whiting 

resource before (as baseline plot) and after (as overlay plot) the imposition of the strategies 

you choose to test. The baseline plots will always be displayed and the overlay plots appear 

following the run of a management strategy. 

To display graphs of Fishing Morality Rates, Legal Size Biomass, Catch by Weight, and 

Recruitment, select ResultslStrategy Time Plots. Each plot can be enlarged to fill the 

WhitSim window by clicking on the enlarge button at the top right of each window. One or 

more of the three individual regions can be viewed by clicking in the checkboxes to the right 
of the speed buttons. The following paragraphs explain what each of these graphs refers to and 

how each result is calculated. 

8.1.1. Fishing Mortality Rate (F) 

The fishing mortality indicates the proportion of the legal sized population (fish greater than 
the legal minimum length) which is being harvested in any short time period. This is a critical 

indicator for stock management and is sometimes difficult to estimate. The baseline estimates 
presented were obtained in the parameter estimation procedure for this model. Reducing 

fishing mortality rate is often the most effective means to enhance stock abundance, and since 
lower fishing mortality is generally achieved by less fishing, this has the additional economic 
benefit of reducing the costs of fishing by the commercial sector. 

Fishing mortality rates can be viewed in more detail, by spatial cell and/or region on either a 
monthly or yearly time scale by selecting Stock Indicators from the Results menu. See Section 

8.5. 

8.1.2. Legal Size Biomass 

Legal size biomass refers to the estimated weight (in kilograms) of King George whiting that 

are greater than the legal minimum length. It describes the amount of fish out there that are 
liable to be harvested. Increasing the legal minimum length (in particular, by means other than 

changing the legal minimum length) increases the amount of egg production reducing the 
chance of, and leaves a higher density of fish in the water, making them easier to catch, again, 

providing the economic benefit to both recreational and commercial sectors of bigger catches 

for the same amount of fishing effort. 

Legal Size Biomass (and Total Exploitable Population numbers) can be viewed in more detail, 

by spatial cell and/or region on either a monthly or yearly time scale by selecting Stock 

Indicators from the Results menu. See Section 8.5. 
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8.1.3. Catch by Weight 

The monthly catches, summed over all gear types, are shown for each month. Catch by weight 

can be viewed in more detail, by selecting Catch by Weight from the Results menu. This 

allows you to view the catch weight for specific spatial cells and/or regions, and for specific 

gear types. Additionally, this screen allows you to view the historical fishery data for 

comparison with the baseline default and the results of your chosen strategy. See Section 8.4 

for more details regarding this screen. 

8.1.4. Recruitment 

Recruitment is the number of I-year olds arriving yearly into the King George whiting 

population. This a critical input to the model estimated, as noted earlier, from catch and effort 

and catch-at-age data. There is no stock-recruitment relationship assumed in the simulator 

since, as the user can view in the Stock-Recruitment screen, no evidence for such a relationship 

is apparent. Recruitment in all spatial cells and years are therefore fixed, input as the estimated 

values. 

Selecting Stock-Recruitment from the Results menu allows you to view yearly recruitment 

plotted against yearly egg production. This provides an opportunity to graphically examine the 

stock-recruitment relationship. This can be done for each of the two Gulf regions. Evidence is 

strong that each of these regions is a discrete (at least largely) self-sustaining population. See 

Section 8.6. 

8.2. Catch at Age 

Catch at age results can be viewed as Numbers by cohort spawned or Relative frequencies. 

The former gives the absolute numbers harvested in the model population. The latter shows 
the age distribution as proportions in each cohort age. 

8.2.1. Numbers by cohort spawned 

To view catch numbers by cohort spawned, select Numbers by Cohort Spawned from the 

Catch at Age sub-menu. This will display male and female results as two separate graphs. 

These plots show the simulated catch broken down into age categories. Subtracting the year 

corresponding to each bar on the graph (year of spawning) from the year displayed above the 

scrollbar (simulated catch year) gives the ages of the fish being caught. The rightmost bar on 

the plot corresponds to two year old fish, increasing by one year for each bar to its left. The 

greatest number of fish are generally caught at age three, as evidenced by the peak of the 

simulated catch occurring at that age. 

Viewing the catch numbers for different spatial cells or regions over time is done using the 

"control box", located to the right of each graph. 

To display catch at age numbers: 

1. Enlarge the graph you are interested in by clicking the maximise button at the top right

of either the males or females graph window. This will also result in the control panel

being fully visible.

2. If you are interested in a particular spatial cell, use the Spatial Cells scrollbar to select
the spatial cell to be displayed. Click the arrows at each end, or drag the scrollbar
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using your mouse to the desired spatial cell. 

Alternatively you can view catch number by region by clicking the checkbox next to 

the region(s) you are interested in. Regions can be displayed individually or as an 

aggregate depending on which option you select. It doesn't matter which spatial cell 

the Spatial Cell scrollbar is set on if the results are displayed by region. 

3. Use the Simulation Month scrollbar to select the year in which you are interested, or

click the mouse over the down arrow of the Simulation Month scrollbar and hold it

there to view a moving picture of the catch by age over time.

The following example shows the control settings and resultant graph for female catches by 

age, individually for the three regions in November in 1992. 
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8.2.2. Relative frequencies 

To view catch numbers as frequency histograms, select Relative Frequencies from the Catch 

at Age sub-menu. This displays the same catch at age data as described in the previous 

section, but expresses it in terms of a proportion instead of absolute numbers. The graphs are 

displayed by using the control settings as described above. The following graph is the same 

example as above, but displayed as frequencies. 
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Selecting Egg Production from the Results menu displays the total number of eggs released 

by females in each simulation year from 1977 to 1999 for each of the three regions. After 

running a new management strategy, this screen overlays the results with the baseline scenario, 

indicating how egg production is altered under the changed regime. 

8.4. Catch by Weight 

The Catch by Weight option from the Results menu displays the total catch (kg) for each 

spatial cell or region, showing both model output and historical data, from 1983 to 1998. Data 

needs to be selected before the graph is displayed. 
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Displaying the Catch by weight data: 

1. Select the data to be displayed by clicking in one or more of the checkboxes associated

with the baseline, overlay and/or historical data. The baseline simulation is the models fit

to the historical data so displaying these two sets of data historical data together gives an

indication of how well the baseline model fits to the historical data. If a management

strategy has been run you can view it by selecting overlay Simulation, otherwise this

option will be disabled. Displaying your overlay scenario together with the baseline

default will provide a comparison over the years in which your management strategy was

imposed.

2. Data can be displayed by region or spatial cell:

(a) by Region:

i) To display one or more regions click on the Regional Zones radio button. Note

that the spatial cells checkboxes are greyed out.

ii) Choose the regions you wish to display by clicking in the checkbox alongside the

particular region(s).

iii) If you have selected more than one region for display and want your selected

regions to be aggregated into a single line plot, click in the Aggregate Spatial

Cells checkbox. If this checkbox is not selected a separate line plot will be

displayed for each region.

(b) by spatial cell:

i) To display the data by individual spatial cell click on the Individual Cells radio

button. Note that the regional checkboxes are greyed out.

ii) Choose the spatial cells you wish to display by clicking in the checkbox alongside

the particular spatial cell(s).

iii) If you have selected more than one spatial cell for display and want your selected

spatial cells to be aggregated into a single line plot, click in the Aggregate Spatial

Cells checkbox. If this checkbox is not selected a separate line plot will be

displayed for each spatial cell.

3. Data can also be displayed according to gear type. The gear type panel lists the different

gear type selections.

(a) Click the checkbox(es) along side the gear type(s) to be displayed.

(b) The data will be displayed aggregated across the selected gear types if the Aggregate

Gear type checkbox is switched on, otherwise the data will be displayed as a separate

line plot for each gear type selected.

4. To display the selected data or to update the plot after changing the data selection, click on

the button labelled Update Graph.

The following screen displays the results after running a management strategy introduced in 

1987. The baseline and overlay data are displayed for Spencer Gulf, haul net catches only. 

Note that the overlay scenario does not diverge from the baseline until 1987, when the altered 

fishing regulations began. Note also that although the Aggregate Spatial Cells and 

Aggregate Gear Type checkboxes are switched on, the graph would be the same if they were 

switched off as only one region and gear type was been selected. 
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To print the displayed graph click.on the button marked Print Graph. 

8.4.2. Enlarging the Graph 

Clicking the button marked Enlarge Graph creates a copy of the graph which can be enlarged 

to the desired size by dragging the comer of the graph or to it's maximum size by clicking the 

maximise button at the top right of the window. Close this copy of the graph by clicking on 

the close button at the top right of the window. 

8.4.3. Creating Reports 

Pressing the button marked Create Report will open a text file containing the displayed data. 

This file can be saved if desired by selecting Save from Notepad's file menu. To close the 

report file click Exit from Notepad's File menu or click on the close button at the top right of 

Notepad's window. 
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8.5. Stock Indicators 

The Stock Indicators option from the Results menu displays a choice of three line graphs 

describing the exploitable population: legal size biomass, total exploitable population and 

fishing morality rates. Data needs to be selected before the graph is displayed. 

To select the stock indicators data: 

1. Select the variable to be displayed. Below the Update Graph button, under the heading

Displayed Variable, is a drop down list of the three variables available for display. Click

on the down arrow on the right hand side of this box and choose the variable you want

displayed. Select whether you want it displayed yearly or monthly by clicking on the

appropriate radio button, located immediately below the Update Graph button. The

example below illustrates that the variable "Legal Size Biomass" has been selected for

display. Note that the Include Overlay Data checkbox has not been selected, therefore the

resultant graph will be baseline values only. Clicking on this checkbox will display both

baseline and overlay data for comparison.

2. Data can be displayed by region or spatial cell:

(a) by Region:

i) To display one or more regions click on the Regional Zones radio button. Note

that the spatial cells checkboxes are greyed out.

ii) Choose the regions you wish to display by clicking in the checkbox alongside the

particular region(s).

iii) If you have selected more than one region for display and want your selected

regions to be aggregated into a single line plot, click in the Aggregate Spatial

Cells checkbox. If this checkbox is not selected a separate line plot will be

displayed for each region.

(b) by spatial cell:
i) To display the data by individual spatial cell click on the Individual Cells radio

button. Note that the regional checkboxes are greyed out.

ii) Choose the spatial cells you wish to display by clicking in the checkbox alongside

the particular spatial cell(s).

iii) If you have selected more than one spatial cell for display and want your selected

spatial cells to be aggregated into a single line plot, click in the Aggregate Spatial

Cells checkbox. If this checkbox is not selected a separate line plot will be

displayed for each spatial cell.

36 



1 

1 

fl 

D 

n 

n 

n 

11 

11 

11 

11 

lJ 

lJ 

l I

l I

u 

u 

lJ 

u 

u 

SA King George Whiting Management Model 

The example below illustrates that Gulf St. Vincent data is to be displayed, by individual 

spatial cell. 

Spatial Cell Selection r flegional Zones 
Co Individual Ceh 

r: Aggregate Spatial Cells 

r I, 1r" r ::,p,;r ,uli r r.,,11 j• ,,n P"' r ·1, r 

r Spatial Cell 1 r Spatial Cell 4 � Spatial Cel 7 n Spatial Cell 13 

C Spatial Cell 2 C Spatial Cell 5 Ri Spatial Cel 8 

[J Spatial Cell 3 C Spatial Cell 6 Ri Spatial Cel 9 

r Spatial Cell 12 � Spatial Cel 10 

M [?._patial Cel 11l 

3. To display the selected data, or to update the graph after changing the settings click on the

Update Graph button.

The following example displays the catch data and settings described above. 
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8.6. Stock-Recruitment 

Recruitment, and its relationship to adult stock biomass, if possible, as yearly egg production, 

are important quantities for managing any exploited population. As noted above in Section 

8.1.4., the user can graphically inspect the relationship of yearly recruitment versus egg 

production by examining the scatterplots formed from the estimates of these two time series 

plotted for all the years available. However, because little is known about spawning or 

recruitment of King George whiting in the West Coast cells, and since no reliable estimates of 

egg production were possible, no stock-recruitment relationship is shown for that region. 

Selecting Stock-Recruitment from the Results menu allows you to view these scatterplots for 

the two reproductively distinct Gulf subpopulations. 

Baseline data and, if a management strategy has been run, overlay data can be displayed 

together for comparison or separately by clicking in the corresponding checkboxes. Only one 

region can be displayed at a time and is done by clicking the appropriate radio button. The 

example below shows the baseline graph for the Gulf St. Vincent. 
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9. Example: changing Legal Minimum Length
The purpose of this model is to test different management options. You can choose from a 

wide range of management regulations or combine a number of different regulations at one 
time. For example, as described in the previous sections, you can change the months open to 

fishing through seasonal closure, control effort, change the minimum legal size of whiting, or 

introduce a quota. All of these policies can be controlled on a year-by-year basis. 

In this chapter we present a detailed step-by-step example to demonstrate how the model is 

used to test a specific management strategy. We consider an increase in minimum length to 

320 mm, introduced in 1987. 

We first present is a general overview of how to test different management options: 

• Click on the Strategy menu and select the strategy for testing. In the resulting dialog box

make changes to any of the parameters found there, as described in Chapter 6. Confirm
your choice by clicking OK.

• From the Simulate menu choose Overlay Model to run the model for the strategy you are

interested in. Looking in Results, you can now compare your option with the model's

historical reconstruction. Does your management strategy result in increases or decreases in

catches, fishable biomass or total egg production?

• Looking in Results, you can now compare your option with the model's historical

reconstruction. Does your management strategy result in increases or decreases in catches,

fishable biomass or total egg production?

At first, introduce one change at a time. When you understand the effects of one management 

change try an additional one and do another model run. This will allow you to compare the 

effects of each strategy on egg production, catch, stock-recruitment, fishable biomass and 

exploitation rate. 

To change the minimum legal size, follow these steps: 

1. From the File menu choose New Project. This avoids combining your most recent

regulation changes with previous ones.

2. From the Strategy menu choose Legal Minimum Length. The present legal minimum

length is set to 280 mm, increasing to 300 mm in September 1995.

3. To impose a new legal minimum length, select the year from which the change will take

effect. We would like to introduce our change from 1987. This is done by clicking on

the right side of the scrollbar until the year displayed below the scrollbar reaches 1987.

4. To set the new value of 320 mm click on the radio button corresponding to that value

and confirm the new value by clicking on the Set Values button. The graph will update

automatically to the new regime. Subsequent years could also be changed to different
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legal minimum lengths, but we will leave it as is for this example. 

5. Click OK to save these changes and exit the dialog box. Clicking on Set Defaults will

delete any changes and reset the default values, or clicking on Cancel will also restore

the default values and exit the dialog box.

6. To run the model with the new regulations, click on the Simulate menu. Make sure

that the mode is set to Run Overlay Model, then click on Execute. The model will

take a few seconds to begin running, but a status message will appear in the dialog box

indicating that it is initialising simulator parameters. While the model is running
(approximately one and a half minutes) try to predict what you think will be the

outcome of your chosen strategy.

7. Display the outcome of the model run by clicking Results and selecting the output you

are interested in. In particular, choose Strategy Time Plots to display fishing mortality

rate, catch by weight, legal size biomass and recruitment. To get a better view of these
graphs, enlarge the WhitSim window if you haven't already done so by clicking on the

maximise button (the middle button at the top right of the WhitSim window). Enlarge

the particular window you are interested in by clicking on the maximise button for that

particular window. This window can be shrunk back down by clicking on the restore

button at the top right of that window (below WhitSim buttons).

Both the baseline (default) and overlay (new strategy) results are displayed for each 

fishing region. Select any combination of regions displayed by clicking in the 

checkboxes located to the right of the speed buttons. It is easier to see the general 

results of the management strategy by viewing one region at a time. Note that by 

clicking on these regions the graph window will restore to its original size so you will 

need to enlarge it again after selecting the region. 

From these graphs you see that an increase in minimum size does not affect fishing 

mortality at all since this is defined as the (daily) proportion of the legal population 

harvested, and though the legal population has been reduced, the fraction of it that's 

harvested has not. Likewise, as noted above, recruitment is fixed at the yearly 

estimated values for each spatial cell. Catch by weight shows a slight decrease in all 

regions. Legal Size Biomass shows a significant decline, as would be expected from an 

increase in legal minimum length. Looking at Egg Production from the Results menu 

indicates there is a substantial increase in egg production for all regions. 

8. If you want to save this management strategy, and haven't done so already, do it before

making any further changes. To save them as a project you can re-examine and modify

later, click on the Save speed button, or File!Save As ... to bring up the dialog box.

Type in a new project name, making sure to add the .pro extension, and click OK.
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